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Enhancements

1) New American RC Code : ACI318-19 (for US.SI)

2) New Taiwanese RC Code : TWN-USD111 

3) Beam-Column Joints check for Existing Building as per NTC2018

4) Crack Control Check for RC Column as per EC2:04 & NTC

5) SCWB Design/Checking Method Option as per ACI Series

6) Thailand Code : DPT (Wind and Seismic load)

7) Addition of Thailand DB(TIS for SI,MKS)

8) Addition of Indonesia DB(SNI)

9) Earthquake Scaling Calculator

10) Preview function of Start Page

11) Revit 2022 Interface

• midas Gen
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1. New American RC Code : ACI318-19 (US.SI)

Add ACI318-19(US)/ACI318M-19(SI) Code for RC Design

Design Result Table

Graphic Report Concrete Design Code

Detail Report
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1. New American RC Code : ACI318-19 (US.SI)

Add ACI318-19 Load combinations
For Concrete Design

Provision Load factors and combinations Remark

Strength

Load Combinations

1.4 (D+F)

• D : Dead Load

• F : Fluid Load

• T : Temperature Load

• H : Lateral pressure load of soil and water in soil 

• L : Live load

• Lr : Roof live load

• R : Rain load

• W : Wind load

• E : Earthquake load (=Eh + Ev)

• Em : maximum effect of horizontal and vertical ea

rth-quake force (=Ω0Eh)

• Ω0 : Seismic force amplification factor

• Eh : Horizontal earthquake load 

• Ev : Vertical earthquake load (not provided in Gen2

022 v1.1)

1.2(D+F+T) +1.6(L+H) + 0.5(Lr or R)

1.2D +1.6(Lr or R) + (1.0L or 0.5W)

1.2D ± 1.0W + 1.0L +0.5(Lr or R)

1.2D ± 1.0E + 1.0L

0.9D ± 1.0W + 1.6H

0.9D ± 1.0E + 1.6H

Allowable stress

Load Combinations

D + F

D + H + F + L + T

D + H + F + (Lr or R)

D + H + F + 0.75[L+T(Lr or R)]

D + H + F ± (0.6W or E / 1.4)

Special load 

combinations

1.2D + 1.0L +1.0Em

0.9D ± 1.0Em
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1. New American RC Code : ACI318-19 (US.SI)

Add New Rebar DB and material as per  ASTM19

Rebar strength as per ASTM 19

Set Rebar Material

Tensile Strength
Fu (psi)

Yield Strength
Fy (psi)

Grade 40 60,000 40,000

Grade 60 80,000 60,000

Grade 80 100,000 80,000

Grade 100 117,000 10,000

Rebar DB as per ASTM19 &  Design rebar setting 
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2.New Taiwanese RC Code : TWN-USD111

Add TWN-USD111 Code for RC Design

Design Result Table

Graphic Report Concrete Design Code

Detail Report
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2.New Taiwanese RC Code : TWN-USD111

Add TWN-USD111 Load combinations
For Concrete Design

Provision Load factors and combinations Remark

Strength

Load Combinations

1.4 D

• D : Dead load

• L : Live load

• Lr : Roof live load

• S : Snow load

• R : Rain load

• W : Wind load

• E : Earthquake load

1.2D+1.6L + 0.5(Lr or S or R)

1.2D +1.6(Lr or S or R) + (1.0L or 0.8W)

1.2D ± 1.6W + 1.0L +0.5(Lr or S or R)

1.2D ± 1.0E + 1.0L +0.2S

0.9D ± 1.6W 

0.9D ± 1.0E 

Table 5.3.1 Load Combinations 
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2.New Taiwanese RC Code : TWN-USD111

Add Concrete/Rebar DB and material as per  CNS560-18

Rebar strength as per CNS560-18

Set Rebar Material

Yield Strength
Fy (kgf/cm2)

SD280 2,800

SD280W 2,800

SD420 4,200

SD420W 4,200

SD490W 5,000

SD550W 5,600

SD690 7,000

Concrete Material DB
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Beam-Column Joints Capacity check for existing building 

Capacity : by Equation below

Demand : Joints Stress, σjt and σjc

Demand  ≤ Capacity → O.K 

Demand  > Capacity → N.G.

Set Existing Joint Check Parameters

• Design > result > Concrete Design > Existing Joint Check

Result Table for Joint Capacity check for existing building 

3. Beam-Column Joints check for Existing Building as per NTC2018

Tensile stress

Compressive stress
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Beam-Column Joints check for existing building 

• Design > result > Concrete Design > Existing Joint Check

Result Table for Beam-Column Joint check for Existing Building 

3. Beam-Column Joints check for Existing Building as per NTC2018

Where,

1) N : Axial force acting on the upper column

(+ : compressive,-:tensile)

2) Vj : Total shear acting on the joint, obtained as a 

sum algebraic of the shear transmitted by the upper 

pillar and of the horizontal stresses transmitted by the 

upper parts of the beams

3)Aj : bj * hjc

where bj and hjc are defined in § 7.4.4.3.1 of the NTC

C8.7.2.3.5 Beam and Column for Existing Building as per CIRCOLARE NTC2018

✓ Note

[Calculation & check of diagonal tensile stress for beam-column joint]

[Calculation & check of diagonal compressive stress for beam-column joint]

1) This check option is activated only with NTC2018.

2) If ‘Apply Special Provision for Seismic Design’ of 

concrete design code is active, this check option can’t 

be activated. 

3) This check must be performed only for ‘Not Confined 

Joint’ as defined in § 7.4.4.3 of the NTC

4) This check is 'existing structure review', so it is 

calculated using the beam reinforcement information 

entered by the user.

✓ Use Tips
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RC Column Crack Widths Check as per EC2:04  & NTC2018

Set Beam-Column Joint Design Parameter

4. Crack Control Check for RC Column as per EC2:04 & NTC

RC Column Check

Check the serviceability check

Graphic Result

Detail Result

When cracked section,
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RC Column Crack Widths Check as per EC2:04  & NTC2018

Calculating effective area of concrete in tension ,Ac,eff ,in program 

[ Rectangular and Circular Column]

4. Crack Control Check for RC Column as per EC2:04 & NTC

- For determing εsm- εcm

1) εsm : The mean strain in the reinforcement under the relevant 

combination of loads, including the effect of imposed deformations 

and taking into account the effects of tensile stiffening.

2) εcm : The mean strain in the concrete between cracks.

3) σs :The stress in the tension reinforcement

4) αe : Es / Ecm.

5) Kt : factor dependent on duration of the load.

0.6 for short-term load, 0.4 for long-term load 

6) ρp,eff : As / Ac,eff

- For determing Sr.max

1) ɸ :bar diameter. The program uses the ɸ of the outer layer.

2) c :  cover to the longitudinal reinforcement.

3)k1 : A coefficient accounting the bond properties of rebar (0.8 for 

high bond bars)

4)k2 : Coefficient accounting for distribution of strain. (0.5 for 

bending)

5)k3 : 3.4 (recommended values)

6) k4 : 0.425(recommended values)

Calculate crack width using the following formular as per EC2:04 and NTC

✓ Note

1. Determine  εsm- εcm

2. Determine Sr.max

1) The stress control for cracked section is performed on 

each axis in program, Also crack control is performed on 

each axis (y & z axis)

2) In GSD, you can also check stress control for cracked 

section on bi-axis.

3) For calculating effective area of concrete in tension for 

circular cross sections(Ac,eff), program use the proposal 

by Wiese et al (left side)

✓ Use Tips
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Add Nominal Strength Method for design force calculation special provision for seismic design

5. SCWB Design/Checking Method Option as per ACI Series

• Design > RC Design> Design Code > SCWB Design/Checking Method

SCWB Design/Checking Option

1.Column design moment as per options 

performing Ductile Design& Checking

[Design  Strength Method] Using the Design strength of beams, ∅𝒃𝑴𝒏

𝑴𝒄,𝑩 =
𝟔

𝟓
∅𝒃𝑴𝒏𝒃,𝑳 + ∅𝒃𝑴𝒏𝒃,𝑹

𝑴𝒄𝒆,𝑩

𝑴𝒄𝒆,𝑻+𝑴𝒄𝒆,𝑩

𝑴𝒄,𝑻 =
𝟔

𝟓
∅𝒃𝑴𝒏𝒃,𝑳 + ∅𝒃𝑴𝒏𝒃,𝑹

𝑴𝒄𝒆,𝑻

𝑴𝒄𝒆,𝑻+𝑴𝒄𝒆,𝑩

[Nominal Strength Method] Using the nominal strength of beams, 𝑴𝒏

𝑴𝒄,𝑩 =
𝟔

𝟓
𝑴𝒏𝒃,𝑳 +𝑴𝒏𝒃,𝑹

𝑴𝒄𝒆,𝑩

𝑴𝒄𝒆,𝑻+𝑴𝒄𝒆,𝑩

𝑴𝒄,𝑻 =
𝟔

𝟓
𝑴𝒏𝒃,𝑳 +𝑴𝒏𝒃,𝑹

𝑴𝒄𝒆,𝑻

𝑴𝒄𝒆,𝑻+𝑴𝒄𝒆,𝑩

[Design  Strength Method] Using the Design strength of beams and 

Column, ∅𝒃𝑴𝒏𝒃, ∅𝒄𝑴𝒏𝒄

𝑹𝒂𝒕𝒊𝒐 = 
∅𝒄𝑴𝒏𝒄,𝑻+∅𝒄𝑴𝒏𝒄,𝑩

∅𝒃𝑴𝒏𝒃,𝑳+∅𝒃𝑴𝒏𝒃,𝑹

[Nominal Strength Method] Using the nominal strength of 

beams&Column , 𝑴𝒏𝒃, 𝑴𝒏𝒄

𝑹𝒂𝒕𝒊𝒐 = 
𝑴𝒏𝒄,𝑻+𝑴𝒏𝒄,𝑩

𝑴𝒏𝒃,𝑳+𝑴𝒏𝒃,𝑹

1) The applied codes is ACI318-19,14(including M), NSR-10, NSCP2015

2) This option can be activated when  

① ACI 318-19,14 , NSCP-2015: Special Moment Frames in Seismic Design 

Parameter

② NSR-10 : DES(Special Energy Dissipation) or DMO (Moderate Energy 

Dissipation) Class in Seismic Design Parameter

✓ Use Tips

2.SCWB Ratio Calculation as per options 

performing SCWB Design & Checking

✓ Note
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6. Thailand Code : DPT (Wind and Seismic load)

Add DPT.1311-50:2007(Wind Load)
Wind Load

Wind load profile per DPT1311-05(2007)

Wind load Calc.Sheet per DPT1311-05(2007) 
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6. Thailand Code : DPT (Wind and Seismic load)

Add DPT.1301/1302-61:2018(Seismic Load)

Static seismic Load Response Spectrum

Auto-Draw Response Spectrum Functions 

per  DPT1301/1302-61(2018))

Define Factors per DPT1301/1302-61(2018)
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7. Addition of Thailand DB(TIS for SI,MKS)

Add Concrete/Rebar DB and material as per TIS(for SI,MKS Unit system)

Tensile Strength
Fu (MPa)

Yield Strength
Fy (MPa)

Yield Strength
Fy (KSC)

SR 24 385 235 2400

SD 30 480 295 3000

SD 40 560 390 4000

SD 50 620 490 5000

Rebar strength as per TIS

Set Rebar Material Concrete strength as per TIS

Rebar DB as per TIS &  Design rebar setting 



Gen 2022 v1.1 Release Note

18 /23

midas Genmidas Gen

8. Addition of Indonesia DB(SNI)

Add Concrete/Rebar DB and material as per SNI

Rebar strength as per SNI

Set Rebar Material

Grade
Tensile Strength

Fu (MPa)
Yield Strength

Fy (MPa)
BjTP 280 350 280

BjTS 280 350 280

BjTS 420A 525 420

BjTS 420B 525 420

BjTS 520 650 520

BjTS 550 687.5 550

BjTS 700 805 700

Concrete strength as per SNI

Rebar DB as per SNI &  Design rebar setting 
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9. Earthquake Scaling Calculator

Input Seismic wave and 
target spectrum

Setting of Scaling method and scale factor

Check Scaling Results 
and Export Results

-Function : Scaling so that the average of the SRSS spectrum of the input seismic wave is greater than 

or equal to the target spectrum for the target period
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9. Earthquake Scaling Calculator

-Tools > Generator > Earthquake Scaling

1

2

3

4

Enter seismic wave information considering 

the conditions of the ground where the 

structure is located.

Import seismic waves saved as SGS files or 

copy and paste input data into Excel format.

Set the design response spectrum 

according to the standard and input the 

magnification of the target spectrum.

When inputting the design response 

spectrum, a certain section of acceleration 

is automatically divided

Set the scaling target period.

Import and export input data as wzd files.

1

2

3

4
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9. Earthquake Scaling Calculator

-Tools > Generator > Earthquake Scaling

▪ Example of excel export

▪ Example of T.H function export

5

6

7

Set the method and scale factor of earthquake scaling control.

Check the scaling results in spectrum and acceleration graphs.

The scaled seismic wave results can be exported as SGS files or time 

history functions, or saved as Excel files.

5

6

7
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10. Preview function of Start Page

-You can see the latest news of midas program in banner.

-Recent projects can be previewed and opened by clicking on the list.
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11. Revit 2022 Interface

Gen-Revit Linker
Functions Revit <> Gen

Linear 

Elements

Structural Column  <>

Beam  <>

Brace  <>

Curved Beam  >

Beam System  >

Truss  >

Planar

Elements

Foundation Slab  <>

Structural Floor  <>

Structural Wall  <>

Wall Opening & Window  >

Door  >

Vertical or Shaft Opening  >

Boundary

Offset  >

Rigid Link  >

Cross-Section Rotation  >

End Release  >

Isolated Foundation Support  >

Point Boundary Condition  >

Line Boundary Condition  >

Wall Foundation  >

Area Boundary Condition  >

Load

Load Nature  >

Load Case  >

Load Combination  >

Hosted Point Load  >

Hosted Line Load  >

Hosted Area Load  >

Other 

Parameters

Material  <>

Level >

▪ File > Import > midas Gen MGT File

▪ File > Export > midas Gen MGT File

Revit 2022 Gen2022 v1.1 (New version)

Send Model to midas Gen


